MAX11300 (PIXI) Programmable Mixed-Signal I/O Device Applications Tutorial

UG6487; Rev 0; 1/18

Abstract: This user guide is a practical cookbook introducing a wide range of solutions for MAX11300 PIXI™ applications, including application ideas for each individual functional component of PIXI, detailed configuration and bench test results, and application cases for PIXI.
## Contents

MAX11300 (PIXI) Device Overview .................................................................................. 6

Analog-to-Digital Converter (ADC) .................................................................................. 7

- Multichannel ADC .................................................................................................. 8
  - Description ....................................................................................................... 8
  - PIXI Implementation ....................................................................................... 9
  - Test Methodology ........................................................................................... 11
  - Test Procedure ............................................................................................... 11
  - Test Results .................................................................................................... 11

- Differential ADC .................................................................................................. 13
  - Description ....................................................................................................... 13
  - PIXI Implementation ....................................................................................... 13
  - Test Methodology ........................................................................................... 15
  - Test Procedure ............................................................................................... 15
  - Test Results .................................................................................................... 15

- Pseudo-Differential ADC ....................................................................................... 16
  - Description ....................................................................................................... 16
  - PIXI Implementation ....................................................................................... 17
  - Test Methodology ........................................................................................... 17
  - Test Procedure ............................................................................................... 18
  - Test Results .................................................................................................... 18

Digital-to-Analog Converter (DAC) ................................................................................ 20

- Driving High Current with Multiple DACs ............................................................ 20
  - Description ....................................................................................................... 21
  - PIXI Implementation ....................................................................................... 21
  - Test Methodology ........................................................................................... 22
  - Test Procedure ............................................................................................... 22
  - Test Results .................................................................................................... 22

- Current Sensing with ADC, DAC, and Resistors ..................................................... 23
  - Description ....................................................................................................... 23
  - PIXI Implementation ....................................................................................... 24
  - Test Methodology ........................................................................................... 25
  - Test Procedure ............................................................................................... 25
List of Figures
Figure 1. PIXI Internal Architecture of ADC with Single-Ended Input ........................................... 8
Figure 2. PIXI Implementation of 4-Channel ADC ........................................................................ 9
Figure 3. 4-Channel ADC Configuration ....................................................................................... 9
Figure 4. Property Setting of Single-Ended ADC ......................................................................... 10
Figure 5. Parameter Setting Window .......................................................................................... 10
Figure 6. Input Signal from Waveform Generator .......................................................................... 11
Figure 7. Munich GUI Window .................................................................................................. 12
Figure 8. 4-Channel ADC Sampling Result ................................................................................. 12
Figure 9. ADC with Differential Input ....................................................................................... 13
Figure 10. Differential ADC ....................................................................................................... 13
Figure 11. Property Setting of Differential ADC ....................................................................... 14
Figure 12. Parameter Configuration Window ............................................................................. 14
Figure 13. Input Waveform of Differential ADC ....................................................................... 15
Figure 14. Output Code of Differential ADC ............................................................................. 16
Figure 15. ADC with Pseudo-Differential Input Set by DAC ......................................................... 16
Figure 16. Pseudo-Differential ADC .......................................................................................... 17
Figure 17. Parameter Setting for Pseudo-Differential ADC ......................................................... 17
Figure 18. Input of Pseudo-Differential ADC .......................................................................... 18
Figure 19. Output Code of Pseudo-Differential ADC ................................................................. 19
Figure 20. DAC Configuration .................................................................................................. 20
Figure 21. Multiple-Channel DAC Driver ................................................................................... 20
Figure 22. LED Driver Circuit .................................................................................................... 21
Figure 23. Test Setup ................................................................................................................ 21
Figure 24. PIXI Current-Sensing Circuit ................................................................................. 23
Figure 25. Current-Sensing Schematic with Resistor Value ......................................................... 24
Figure 26. SPST,DPST,SPDT Analog Switch ........................................................................... 27
Figure 27. SPST Analog Switch ................................................................................................ 28
Figure 28. DPST Analog Switch ................................................................................................ 28
Figure 29. SPDT Analog Switch ................................................................................................ 29
Figure 30. Input and Output of SPST ....................................................................................... 30
Figure 31. Input and Output of DPST ........................................................................................ 31
List of Tables

Table 1. Single-Sweep Mode Timing ................................................................. 8
Table 2. Load Current Calculation ................................................................. 25
Table 3. 4:1 Mux Logic Table ...................................................................... 35
MAX11300 (PIXI) Device Overview

The **MAX11300** is a programmable mixed-signal I/O device featuring PIXI™ technology. This IC offers 20 mixed-signal high voltage, bipolar ports, which are configurable as an ADC analog input, a DAC analog output, a general-purpose input (GPI), a general-purpose output (GPO), or an analog switch terminal. PIXI programmable mixed-signal I/O devices allow users to instantly reconfigure and adapt their design. The 20 PIXI ports also provide highly flexible hardware configuration for 12-bit mixed-signal application. The device offers one internal and two external temperature sensors.

The MAX11300 can be implemented in different applications. This tutorial starts with a functionality introduction of individual components inside the MAX11300, followed by software configuration and hardware implementation with bench test results.

All hardware applications are based on the **MAX11300 EVKIT** board or the **MAX11300SYS1** evaluation board. Software configurations are based on the MAX11300 Configuration Software, MAX11300 EV KIT Software, or Munich_GUI.

Download the related software and design files [here](#).
Analog-to-Digital Converter (ADC)

The MAX11300 can work as a multichannel (up to 20 channels), high-speed (up to 400ksps), 12-bit, successive approximation analog-to-digital converter. Single-ended ADC, differential ADC, and pseudo-differential ADC can be implemented. Each individual ADC can be programmed for one of four input voltage ranges: 0V to +10V, -5V to +5V, -10V to 0V, and 0V to +2.5V. Internal 2.5V voltage reference, the external ADC voltage reference, or, in some cases, the DAC voltage reference are selectable on a port-by-port basis.

ADC-configured ports can be configured to average blocks of 2, 4, 8, 16, 32, 64, or 128 conversion results. Conversion can be triggered using an external signal CNVT or from a control bit. Four configurations are available:

- **Idle mode (default setting).** ADC is not doing conversion in this mode.
- **Single sweep mode.** The ADC sweeps sequentially the ADC-configured ports, from the lowest index port to the highest index port, once CNVT is asserted.
- **Single conversion mode.** The ADC performs a single conversion at the current port in the series of ADC-configured ports when CNVT is asserted.
- **Continuous sweep mode.** The ADC continuously sweeps the ADC-configured ports. The CNVT port has no effect in this mode.

Two interrupt register bits, ADCFLAG and ADCDR, are used to indicate completion of an ADC conversion. The ADCFLAG (ADC Flag) interrupt indicates that the ADC just completed a conversion or set of conversions. It is asserted either at the end of a conversion when the ADC is in single-conversion mode or at the end of a sweep when the ADC is either in single-sweep mode or continuous-sweep mode. ADCFLAG is cleared when the interrupt register is read. The ADCDR (ADC Data Ready) interrupt is asserted when at least one ADC data register is refreshed. Since one conversion per ADC-configured port is performed per sweep, many sweeps may be required before refreshing the data register of a given ADC-configured port that utilizes the averaging function. To determine which ADC-configured port received a new data sample, the host must read the ADC status registers. ADCDR is cleared after the interrupt register and both ADC status registers are read subsequently.

For example, we configure 4 ports (port 0, 1, 2, 3) in the MAX11300 as single-ended ADC and use average functions of 4 for each port.

If we choose single sweep mode, once we send a CNVT signal, ADC sweeps from port 0 to port 3 one time. ADCFLAG is asserted after one sweep. If this ADCFLAG is not masked, assertion of the ADCFLAG results in an assertion of the interrupt port (INT). ADC data register of port 0 to port 3 are not refreshed until average function of 4 for each port.
port is completed. If ADCDR is not masked, assertion of ADCDR results in an assertion of the interrupt port (INT).

**Table 1. Single-Sweep Mode Timing**

<table>
<thead>
<tr>
<th></th>
<th>Port 0</th>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>ADCFLAG</th>
<th>ADCDR</th>
</tr>
</thead>
<tbody>
<tr>
<td>CNVT</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>Y</td>
<td>NA</td>
</tr>
<tr>
<td>CNVT</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>Y</td>
<td>NA</td>
</tr>
<tr>
<td>CNVT</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>Y</td>
<td>NA</td>
</tr>
<tr>
<td>CNVT</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

If we choose continuous conversion mode, no CNVT signal needs to be sent, and ADC sweeps from port 0 to port 3 continuously. The ADCFLAG is asserted after one sweep. ADCDR is asserted after completion of averaging function.

**Multichannel ADC**

![PIXI Internal Architecture of ADC with Single-Ended Input](image)

**Description**

With single-ended ADC configured on multiple ports at same time, each PIXI port is ADC’s positive input, negative ADC input is grounded internally. PIXI sweeps sequentially the ADC-configured ports, which make these ports work together as a multichannel ADC. PIXI can be configured up to 20-channel ADC, all individual ports can choose different input range and voltage reference type. Figure 2 is an example of 4-channel ADC.
Figure 2. PIXI Implementation of 4-Channel ADC

PIXI Implementation
In this circuit, we configure ports P0 to P3 as single-ended ADC (Figure 3) and apply a common signal to each input port as demonstration.

Figure 3. 4-Channel ADC Configuration
Property setting of each ADC is shown in Figure 4. Average number of samples is 1, internal reference voltage and input voltage range is 0V to 10V.
Parameter configuration is set as below.

![Figure 4. Property Setting of Single-Ended ADC](image)

### Figure 4. Property Setting of Single-Ended ADC

Keep the ADC conversion rate as default 200kspss, set the ADC conversion mode to be “continuous sweep.” In this mode there is no need to set the conversion start command. ADC is continuously going around four ADC-configured ports (P0 → P1 → P2 → P3 → P0 → P1, etc.) and ADC data register is updated automatically with new data.

Save this configuration file and generate a MAX11300 register file (.csv).
**Test Methodology**

**Required equipment:**

- MAX11300PMB1 board
- USB2PMB1 board
- Micro A-to-B USB
- PC with Windows® OS
- Waveform generator
- Oscilloscope with probe

**Test Procedure**

Connect the MAX11300PMB to the USB2PMB and connect to a PC through a Micro A-to-B USB cable. Open the **Munich GUI** software (Figure 7), ensuring the EV kit connected notice appears on the EV kit GUI. Load the generated MAX11300 register file (.csv) and connect port 0 to port 3 together externally. A ramp signal with a 2kHz frequency, 0V to 2.5V range is applied from the waveform generator to these ports.

**Test Results**

Figure 6 shows the scope shot of the input port. A ramp signal between 0V and 2.5V with 2kHz frequency is applied to four ADC-configured ports at the same time.

![Input to four ADC channels](image)

*Figure 6. Input Signal from Waveform Generator*

The conversion result from the ADC can be collected from the MAX11300PMB board by using **Plot Windows → Get Plot Box → Save ADC file**. Click on **Scan Once**. A 1024 sample from each ADC port is captured. Save data and plot it as shown in Figure 8. We can see that the data from each of channel overlaps with each other.
Figure 7. Munich GUI Window

Figure 8. 4-Channel ADC Sampling Result
Differential ADC

Figure 9. ADC with Differential Input

Description
The ADC can also work in differential mode. Each configured ADC port has the same input range as in single-ended mode. The port configured as negative input of the ADC can be shared by multiple differential ADCs, which can save input wiring if input channels share the same negative input. Compared with single-ended mode, differential ADC has good dynamic common-mode rejection and increased dynamic range, which make differential ADCs have better dynamic performance such as SNR, THD, and SFDR.

Figure 10. Differential ADC

PIXI Implementation
Choose Differential ADC from the components tab of the MAX11300 Configuration Software and connect the positive input of ADC to P10 and the negative input port to P11. Figure 11 shows the property setting. Figure 12 shows how to set the parameter configuration.
Figure 11. Property Setting of Differential ADC

Figure 12. Parameter Configuration Window
**Test Methodology**

Required equipment:

- MAX11300PMB board
- USB2PMB board
- Micro A-to-B USB
- PC with Windows OS
- Signal analyzer
- Oscilloscope with probe

**Test Procedure**

A signal analyzer generates positive and negative sine-wave signals with 180-degree phase difference. Connect port 10 and 11 with +/-625mV amplitude. The full dynamic range of input signal is +/-1.25V. Use the Munich_GUI to capture 1024 sample points into a .csv file and plot.

**Test Results**

Use the oscilloscope to capture the input signal from the signal analyzer as shown in Figure 13.

![Figure 13. Input Waveform of Differential ADC](image)

Plot 1024 data sample from the saved .csv file as shown in Figure 14. With differential input, ADC doubled the input range from +/-625mV to +/-1.25V, with good common-mode rejection.
Figure 14. Output Code of Differential ADC

**Pseudo-Differential ADC**

Description
The ADC can also operate in pseudo-differential mode. Configure one port as a positive input and connect the DC voltage to another port. Configure these two ports as pseudo-differential ADC inputs. ADC input is measured at the positive input with respect to the DC level set at negative input. This configuration can separate signal ground from ADC ground, allowing DC common-mode voltage to be canceled (compared with single-ended inputs). Compared with differential input, pseudo-differential mode has less wiring and has a negligible effect on dynamic common-mode noise.
In pseudo-differential mode, one port is configured as positive input, the other port can be configured to produce voltage from internal DAC or from external supply.

**Figure 16. Pseudo-Differential ADC**

**PIXI Implementation**

Connect the differential ADC to the PIXI input P0 and P1, connect DAC to the negative side of ADC, and set the DAC to 1.25V. Use the internal reference for both differential ADC and DAC, and set the other parameters as shown in Figure 16.

**Figure 17. Parameter Setting for Pseudo-Differential ADC**

**Test Methodology**

Required equipment:

- MAX11300PMB board
- USB2PMB board
- Micro A-to-B USB
- PC with Windows OS
- Waveform generator
- Oscilloscope with probe
Test Procedure
Connect MAX11300PMB to USB2PMB and connect to the PC through a Micro A-to-B USB cable. Open Munich GUI, ensuring the EV kit connected notice appears on the EV kit GUI. Load the MAX11300 register file (.csv) generated from the last step and connect a sine-wave signal with a 1kHz frequency, 0V to 2.5V range from waveform generator to port 0. 1.25V is provided by the DAC internally and can be measured at port 1.

Test Results
Figure 18 is the scope shot captured at port 0 and port 1, where the positive input is a sine wave from 0V to 2.5V, 1kHz, and the negative input is 1.25V DC. Collect 1024 sample point of pseudo-differential ADC from the MAX11300PMB board and plot it as shown in Figure 19. We can see the output amplitude of pseudo-differential ADC is the same as input voltage difference (port 0 to port 1).

Figure 18. Input of Pseudo-Differential ADC
Figure 19. Output Code of Pseudo-Differential ADC
Digital-to-Analog Converter (DAC)
The MAX11300 uses a single 12-bit DAC (configuration is shown in Figure 20) with 20 track-and-hold circuits at each port. The DAC operates at the rate of 40μs per port, with up to 20 ports configured in DAC-related modes. The maximum refresh rate for each port is 0.8ms. With an internal scaling block at each port, the PIXI port driver can drive 0V to 10V, -5V to +5V, and -10V to 0V. The output current can go up to 25mA with dedicated power supplies (AVDDIO, AVSSIO).

The DAC uses either the internal or external voltage reference. Unlike the ADC, the DAC voltage reference is set for all the ports and cannot be configured on a port-by-port basis.

![Figure 20. DAC Configuration](image)

**Figure 20. DAC Configuration**

**Driving High Current with Multiple DACs**

![Figure 21. Multiple-Channel DAC Driver](image)

**Figure 21. Multiple-Channel DAC Driver**
**Description**
The MAX11300 can be used in an application of multichannel LED driver circuits. Since each DAC configured port can drive up to 25mA, an LED can be connected directly to the DAC output as a constant voltage driver (Figure 21). For LEDs that require higher current, a circuit as shown in Figure 22 can be used to amplify current from the DAC output as a high-current LED driver.

![Figure 22. LED Driver Circuit](image)

**PIXI Implementation**
Up to 20 DAC configured ports can work as a constant-voltage LED driver. As shown in Figure 23, connect the DAC in the MAX11300 Configuration Software from port 0 to port 19 and connect an LED (part number: CMD54123) though a 110Ω resistor to ground. Set all DAC voltages to 0V to 10V, internal reference, output level to 5V. Save this configuration and generate a MAX11300 register file (.csv).

![Figure 23. Test Setup](image)
Test Methodology

Required equipment:

- MAX11300EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Multimeter
- LED (part number: CMD54123)
- Resistor (110Ω)

Test Procedure

Make sure 20 LEDs are connected through a 110Ω resistor to ground from port 0 to port 19. Connect the MAX11300EVKIT board through a Micro A-to-B USB cable to the PC, and power-on the MAX11300EVKIT board. Open the MAX11300 EV KIT Software and verify whether the EVKIT connected notice appears in the right lower corner. Load the register file generated from the last step by choosing File → Configuration, then Data → Read Configuration. Make sure the DAC output is 5V from port 0 to port 19.

Test Results

The LEDs at port 0 to port 19 will be on. Use the multimeter to test that the LED forward voltage is 2.2V and the forward current is 25mA, which is the recommend working range. Set the different DAC output voltages at Data → Write Selected. The LED brightness can be adjusted by changing the DAC output voltage.
Current Sensing with ADC, DAC, and Resistors

![Diagram of PIXI Current-Sensing Circuit](image)

**Figure 24. PIXI Current-Sensing Circuit**

**Description**

By using two single-ended ADCs (or one differential input ADC) and an additional DAC, PIXI can sense the current from any of its DACs with nothing more than a handful of resistors and some calculations. Resistors R1–R4 level-shift the ADC inputs down to the ADC’s most sensitive range, regardless of the direction of output current in load.
The idea is to counter the output common-mode voltage seen across the sense resistor with a second DAC, shown in Figure 25 as DAC2. In theory, all the terms can be measured, including the error current $I_{ERROR}$, so the actual load current, $I_{OUT}$ can be calculated. Considering ADC inputs are of the order of 100kΩ, choose the $R_1$–$R_4$ value as 10kΩ. Any mismatch between $R_1$ and $R_2$, and likewise between $R_3$ and $R_4$, creates errors. The accuracy of the sense resistor $R_S$ determines the final accuracy of the circuit.
Test Methodology

Required equipment:

- MAX11300EVKIT Board
- Micro A-to-B USB
- PC with Windows OS
- Through-hole resistor 10kΩ
- Sensing resistor 100Ω
- Potentiometer 0–10kΩ
- Keysight 33250A 80MHz function/arbitrary waveform generator
- Keysight E3631A triple output DC power supply
- Keysight 34401A multimeter

Test Procedure

Load the register file to the **MAX11300 EV KIT Software**. Set the DAC1 and DAC2 range to 0V to 10V and the ADC input range to 0V to 10V. Connect the through-hole resistor Rs, R1–R4, and the potentiometer as load resistor (RLD) to DAC output and ADC input. Measure Rs = 100.0651Ω, R1 = 10.06904kΩ, R2 = 10.07873kΩ, R3 = 10.06262kΩ, R4 = 10.01860kΩ. Change the load potentiometer to a different value and calculate the load current compared with real current as shown below.

\[
V_{ADC1} = (V_{DAC1} + V_{DAC2})/2
\]
\[
V_{ADC2} = (V_{OUT} + V_{DAC2})/2
\]
\[
I_S = (V_{DAC1} - V_{OUT})/R_S
\]
\[
I_S = I_{OUT} + (V_{OUT} - V_{ADC2})/R_3
\]

Load current \(I_{OUT} = 2 \times (V_{ADC1} - V_{ADC2})/R_S - (V_{ADC2} - V_{DAC2})/R_3\)

<table>
<thead>
<tr>
<th>DAC1 (V)</th>
<th>DAC2 (V)</th>
<th>ADC1 (V)</th>
<th>ADC2 (V)</th>
<th>(I_{OUT}) (calculated)</th>
<th>(I_{OUT,REAL}) (mA)</th>
<th>Error %</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>3.005</td>
<td>3.8013</td>
<td>3.6084</td>
<td>3.79552557</td>
<td>3.92743041</td>
<td>3.35855</td>
</tr>
<tr>
<td>5</td>
<td>3.005</td>
<td>3.7988</td>
<td>3.7378</td>
<td>1.14638232</td>
<td>1.13343031</td>
<td>1.142727</td>
</tr>
</tbody>
</table>
Analog Switch

There is an analog switch between the adjacent PIXI ports. Two types of analog switches can be configured in PIXI: one is dynamically controlled by any other GPI-configured PIXI port, and the other one is programmed to be permanently “on” by configuring the corresponding PIXI port. On-resistance of the analog switch is no more than 60Ω. By connecting two analog switches in parallel, the turn-on resistance can be reduced to 30Ω. When the analog switch is controlled by a GPI-configured port, maximum turn-on and turn-off delay is 400ns. The minimum time before the switch can be turned on again is 10μs.

The first switch type involves two adjacent PIXI ports that can be connected through an analog switch controlled by a GPI-configured port. In this mode, three ports involved, configure two ports in mode 11 (terminal to GPI-controlled analog switch mode), then configure any other port in GPI mode. Only the port with the lower index needs to be configured in mode 11; the port with the high index can be configured in any other mode, except bidirectional level translator terminal mode. For example, configure port 0 and port 1 in mode 11, then configure port 2 in GPI mode, define port 0’s port configuration register as mode 11, and define the associated port (port 2) in the port configuration register at port 0 (low index port). Port 1 can be defined in any other mode like ADC or DAC, except bidirectional level translator terminal mode.

The second analog switch type is identical to the first type except that the switch remains closed if the lower index port is configured in mode 12 (terminal to register-controlled analog switch mode).


Figure 26. SPST, DPST, SPDT Analog Switch

Description
The single analog switch can function as single-pole/single-through (SPST), double-pole/single-through (DPST), and single-pole/double-through (SPDT) switches with different connections. In applications that require analog switch-circuit block and integrated with DAC, ADC, GPIO, analog switch inside PIXI, featured with fast-speed, high-signal working range, low turn-on resistance, it is very easy to implement and reduces cost dramatically compared with individual analog switch.

Each port in the MAX11300 can be configured as one of the analog switch terminals. Two adjacent PIXI ports can form an analog switch. A single analog switch controlled by a GPI-configured port can work as a SPST, where the switch’s threshold voltage is configured internally in a GPI-configured port. DPST and SPDT can be implemented by configuring two analog switches with GPI control mode.

PIXI Implementation
For a SPST analog switch, choose a GPI-controlled analog switch in the MAX11300 Configuration Software, connect port 0 and port 1 to two analog switch terminals, and connect GPI-controlled input to port 2. Generate the registration file. Port 0 has mode 11 defined in the port configuration register and is associated with port 2, and port 2 has mode 1 defined. The threshold voltage range at port 2 is 0V to 2.5V, so set it to 1V. See Figure 27.
The DPST analog switch can be implemented by the configuration as shown in Figure 28. Connect ports 5, 6, 7, and 8 to the analog switch terminals, connect two GPI ports together at port 4, set the threshold voltage to 1V, and set the polarity of the second GPI associated port to inverted.

The SPDT switch can also be implemented with two analog switches with different connections from DPST. In the MAX11300 Configuration Software, connect ports 1, 3 to two analog terminals, connect two other analog switch terminals together to port 2, and connect two GPI associated ports to port 0 together, as shown in Figure 29.
**Test Methodology**

Required equipment:

- MAX11300EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Multimeter
- Oscilloscope
- Resistor (10kΩ)

**Test Procedure**

**SPST**

Connect a DC voltage supply to port 0, connect port 1 to a 10kΩ resistor load, and connect a 5Hz pulse wave with 3.3V amplitude, 50% duty cycle to port 2.

**DPST**

Connect two DC voltage supplies (10V and 5V) to port 5 and 7, connect a resistor load to port 6 and 8, and connect a 1kHz 3.3V V<sub>P-P</sub>, 50% duty-cycle pulse wave from a signal generator to port 4.

**SPDT**

Connect port 1 and 3 to two 10kΩ resistor loads, connect port 2 to a 10V DC voltage supply, connect port 0 to a 1kHz 3.3V V<sub>P-P</sub>, 50% duty-cycle pulse wave from signal generator, set the port 0 threshold to 1V, and configure the polarity of first GPI-associated port to inverted.
Test Results

SPST

Port 0 is one terminal of an analog switch connected with 10V voltage supply, port 1 is the other analog switch terminal connected with a 10kΩ resistor load, and port 2 is a 0V to 3.3V control signal. The threshold voltage of the GPI-controlled port is 1V. When the signal is 0V, the analog switch turns off, and the voltage at resistor load is 0V. When the GPI-controlled signal jumps to 3.3V, the analog switch turns on with a 60Ω turn-on resistor, and voltage at resistor load side is closed to 10V.

Figure 30. Input and Output of SPST
**DPST**

Port 5 and port 7 are a DC power supply of +10V and -10V, the control signal is 0V to 3.3V pulse wave at port 4, threshold is 1V, port 6 and 8 are the analog switch load terminals. When the pulse wave is 0V, the first analog switch is off, port 6 voltage is 0V, and the second analog switch is on due to the inverting polarity setting. Port 8 is -10V. When the pulse wave jumps to 3.3V, the first analog switch turns on and the output voltage at port 6 is 10V. The second analog switch turns off, and the output voltage at port 8 is 0V.

![Waveform Diagram](image)

*Figure 31. Input and Output of DPST*
**SPDT**
Two analog switches have a common terminal connected to a 10V power supply at port 2, port 0 connects to signal generator, and ports 1 and 3 are connected to two 10kΩ resistor load. When the GPI-controlled terminal has voltage lower than the 1V threshold, the first analog switch turns on and port 1 has 10 output signals. When the GPI-controlled terminal has 3.3V voltage, the second analog switch turns on, the first analog switch turns off, and port 3 is 10V.

![Figure 32. Input and Output of SPDT](image-url)
4:1 High-Voltage Multiplexer

4:1 analog mux can be implemented with analog switches as shown in Figure 33.

**Figure 33. 4:1 Analog Mux**

**Description**

We can build a multiplexer based on the GPI-controlled analog switch. Here we introduce the implementation of a 4:1 multiplexer consisting of two 2:1 multiplexers. This 4:1 multiplexer can be built with six GPI-controlled analog switches and used in combination with other components in PIXI at the same time. As an analog multiplexer, it is bidirectional and can work as a 4:1 demultiplexer.
PIXI Implementation

In the **MAX11300 Configuration Software**, connect six GPI-controlled analog switches as shown in Figure 34 set the threshold voltage at each GPI-associated port to 1V and set the inverted polarity to the GPI-associated port as shown in Figure 34. Generate a .csv file by choosing **File → Generate Register**.

![Figure 34. 4:1 Mux PIXI Configuration](image_url)

**Test Methodology**

**Required equipment:**

- MAX11300EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Multimeter
- DC power supply
- Oscilloscope
- Resistor (10kΩ)

**Test Procedure**

Power-on the **MAX11300 EV KIT Software**, then load the register file. Connect the DC voltage supply to port 0, 2, 10, 12, with the voltage level as shown in Figure 34 above. Connect a 10kΩ resistor load to port 6. Connect port 1 to port 5 and port 7 to port 11. The
control signal of two 3.3V V_{p-p}, 50% duty-cycle pulse waves is connected from the signal generator to port 3 and 4.

Test Results
Figure 35 shows a scope shot for the input signal and output signal with a GPI-controlled signal. Ports 0, 2, 10, 12 are a four-input signal, ports 3, 4 are a 1Hz and 2Hz control signal connected to GPI-associated port, and port 6 is an output signal. Table 3 shows the output signal corresponding to the voltage level at port 3 and 4 (control signal).

![Scope Shot](image)

*Figure 35. Input and Output of 4:1 Mux*

Table 3. 4:1 Mux Logic Table

<table>
<thead>
<tr>
<th>EN0</th>
<th>EN1</th>
<th>OUTPUT CHANNEL</th>
<th>OUTPUT (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Port 12</td>
<td>-5</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Port 2</td>
<td>-10</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Port 10</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Port 0</td>
<td>10</td>
</tr>
</tbody>
</table>
Programmable Window Comparator

![Diagram of Programmable Window Comparator]

*Figure 36. Programmable Window Comparator*

**Description**

Window comparator consists of two comparators that can be implemented by using two GPI-controlled analog switches as shown in Figure 36. High and low threshold voltage are set by setting the threshold voltage in the GPI-associated ports. Set the polarity in the low threshold to inverting, and set polarity in the high threshold to noninverting.

When the signal in the GPI-associated ports is lower than both the low threshold and high threshold, the analog switch in lowpass turns on, analog switch in highpass turns off, and the output signal is connected to ground through lowpass. When the signal in the GPI-associated ports is higher than the low threshold but lower than the high threshold, both highpass and lowpass turns off, and the output signal is high. When the signal in the GPI-associated ports is higher than the high threshold and low threshold, the highpass signal turns on, lowpass signal turns off, and the output signal is connected to ground through the highpass signal.
**PIXI Implementation**

Figure 37 shows how to connect two GPI-controlled analog switches in a PIXI configuration file. Set the port 0 threshold to 2.5V, polarity is noninverting, and set port 1 to 1V threshold, polarity is inverting.

**Test Methodology**

Required equipment:

- MAX11300EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Multimeter
- DC power supply
- Oscilloscope
- Resistor (2kΩ)

**Test Procedure**

Connect port 11 to the external 3.3V voltage supply through a 2kΩ resistor. Connect port 0 and port 1 together to a signal generator with 100Hz, 3.3Vp-p sine wave. Connect port 10, 12 to ground. Test the output signal at port 11.
Test Results
The output signal goes high when the input signal is higher than 1V and lower than 2.5V. The output signal is 0V when the input signal is lower than the low threshold 1V, or higher than the 2.5V high threshold.

Figure 38. Input and Output of Window Comparator
Unidirectional Logic Level Translator

**Description**

Figure 39 shows the internal structure of unidirectional logic level translator. Configure one port as a GPI, then configure another port as a GPO to form a unidirectional level translator path. The input voltage of the GPI port must be between 0V and 5V. The threshold of the GPI is set through the DAC data register. Any input voltage above that programmed threshold is reported as a logic-one. The data at the GPI port is transmitted by the GPO-associated port. Data from the GPI port can be inverted by asserting the function parameter “INV” in GPO port. In the mode register of the GPO-associated port, the input port of this path is specified by the functional parameter “ASSOCIATED PORT.” Multiple GPO-associated ports can be configured to the same GPI port. This means that one GPI-configured port can transmit its data to multiple GPO ports in unidirectional level translator mode.

**PIXI Implementation**

Figure 40 shows the unidirectional level translator in the PIXI. Connect one port from the PIXI (P2 here) to the input of level translator, then connect the output to any other PIXI port (P12 here). Polarity in the right column is to invert data from the GPI port. The input...
threshold of the GPI-associated port can be set from 0V to 2.5V through the DAC data register. Output voltage from 0V to 10V can be set through the DAC register at the GPO-associated port as logic-one.

The unidirectional level translator can be used to translate a signal to a different voltage level. The programmable input-logic threshold ($V_{\text{ITH}}$) and programmable output-logic level need be set based on the following requirements:

1) Minimum input-high voltage ($V_{\text{IH}}$) is $V_{\text{ITH}} + 0.3V$.
2) Maximum input-low voltage ($V_{\text{IL}}$) is $V_{\text{ITH}} - 0.3V$.

$V_{\text{ITH}}$ is set through the DAC data register, with an applicable range from 0.3V to $V_{\text{DACREF}}$, for internal DAC reference, typical value is 2.5V.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SYMBOL</th>
<th>CONDITIONS</th>
<th>MIN</th>
<th>TYP</th>
<th>MAX</th>
<th>UNITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programmable Input Logic Threshold</td>
<td>$V_{\text{ITH}}$</td>
<td></td>
<td>0.3</td>
<td>$V_{\text{DACREF}}$</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Input High Voltage</td>
<td>$V_{\text{IH}}$</td>
<td></td>
<td>$V_{\text{ITH}} + 0.3$</td>
<td>V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Low Voltage</td>
<td>$V_{\text{IL}}$</td>
<td></td>
<td>$V_{\text{ITH}} - 0.3$</td>
<td>V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hysteresis</td>
<td></td>
<td></td>
<td>±30</td>
<td>mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programmable Output Logic Level</td>
<td>$V_{\text{OLVL}}$</td>
<td></td>
<td>0</td>
<td>$4 \times V_{\text{DACREF}}$</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Propagation Delay from GPI Input to GPO Output in Unidirectional Level Translating Mode</td>
<td></td>
<td></td>
<td>Midscale threshold, 5V logic swing</td>
<td>2</td>
<td>µs</td>
<td></td>
</tr>
</tbody>
</table>

Figure 41. EC Table Parameter

Test Methodology

Required equipment:

- MAX11300 EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Multimeter
- DC power supply
- Oscilloscope

Test Procedure

Here we use a unidirectional level translator to interface the signal between two CMOS devices, 74LVT00D and CD4011BE. According to the data sheet, 74LVT00D is a quad 2-input NAND gate with $V_{\text{IH}}$ of 2.0V, $V_{\text{IL}}$ of 0.8V, $V_{\text{OH}}$ of $V_{\text{CC}} - 0.2V$, and $V_{\text{OL}}$ of 0.5V. CD4011BE is also a quad 2-input NAND gate, with a $V_{\text{IH}}$ of 7V, $V_{\text{IL}}$ of 3V, $V_{\text{OH}}$ of 10V, $V_{\text{OL}}$ of 0V. As shown in Figure 42, a pulse wave from 3.3V to 0V is generated from a signal generator. After going through the 74LVT00D, the output of the 74LVT00D connects to
the unidirectional level translator of the PIXI, and the output of level translator connects to the CD4011BE. The input threshold of the unidirectional level translator is set to 1.5V, and the output voltage of the GPO port is set to 10V. To simplify this demonstration, we use a NAND gate as an inverter.

![Diagram of 3.3V to 10V Level Translator]

**Figure 42. 3.3V to 10V Level Translator**

**Test Results**

![Test Results Waveform]

**Figure 43. Input and Output Waveform**
From the test result in Figure 43, we can see this unidirectional level translator translate a signal from the 74LVT00D (3.3V) to 10V pulse wave and connect to the CD4011BE. The clock frequency of the pulse wave is 1kHz. Propagation delay from input port to output port is 3μs, and the input signal up to 20kHz can be transferred.

![Figure 44. Propagation Delay from Low to High](image)

![Figure 45. Propagation Delay from High to Low](image)
Figure 46. Output Waveform with Input Frequency = 5kHz

Figure 47. Output Waveform with Input Frequency = 20kHz

**PIXI Implementation**

PIXI can also function as a level translator using a GPI-controlled analog switch and DAC. As shown in Figure 48, connect an input signal to the GPI-associated port of the analog switch. When the input signal is higher than the threshold voltage, the switch turns on and the DAC voltage connects to the output. When the switch turns off, connect the output to ground through a pulldown resistor. The DAC output can go up to 6V in a pulldown
configuration. If you use the pullup resistor configuration, the output of the level translator can go up to 10V as shown in Figure 48.

Figure 48. Level Translator with Pulldown Resistor

Figure 49. Level Translator with Pullup Resistor
Test Methodology

Required equipment:

- MAX11300EVKIT
- MAX11300 EV KIT Software
- MAX11300 Configuration Software
- Through-hole resistor 1kΩ, 4.7kΩ
- Keysight E3631A triple-output DC power supply
- Keysight 33250A 80MHz function/arbitrary waveform generator
- WaveSurfer 3034 350MHz oscilloscope

Test Procedure

Level Translator with Pulldown Resistor
Power-up the MAX11300EVKIT board, then load the register file into the EV kit software. Connect signal of 3.3V VP-P pulse wave from signal generator to port 1, and set the threshold voltage to 1V. Connect port 2 through a 1kΩ resistor to ground. Set the DAC data register to output 6V DC signal. Set the frequency of the signal generator to 100kHz and 400kHz and capture the waveform at port 1 and port 2.

Level Translator with Pullup Resistor
Load the register file, connect the waveform generator to port 6, set polarity to inverted, and the threshold of the GPI port to 1V. Connect port 7 to ground, connect a 1kΩ pullup resistor from port 8 to port 9. Set the DAC voltage at port 9 to 10V. Capture the waveform at port 6 and port 8.

Test Results

Level Translator with Pulldown Resistor
Figure 50 is the waveform at port 1 and 2. Port 1 is 3.3V VP-P pulse wave from signal generation, Port 2 is the output at a 1kΩ pulldown resistor. This level translator can work at 400kHz to translate a signal up to 6V (Figure 51).
Figure 50. Pulldown Resistor of 1kΩ at 100kHz

Figure 51. Pulldown Resistor of 1kΩ at 400kHz

**Level Translator with Pullup Resistor**

Figure 52 is waveform at port 6 and port 8. Port 6 is a 100kHz, 3.3V Vp-p pulse wave from signal generation, and port 8 is output at a 1kΩ pullup resistor. Output waveform with 400kHz input signal and 1kΩ pullup resistor is shown in Figure 53. With a higher value ohm pullup resistor, less current flows through the resistor to the ground when the switch turns on, but the response of the output signal when the switch state changes is delayed.
The output voltage level with a 4.7kΩ pullup resistor is lower compared with a 1kΩ pullup resistor, because of a larger voltage drop at the 4.7kΩ pullup resistor.

Figure 52. Output Signal with Pullup Resistor of 1kΩ at 100kHz

Figure 53. Output Signal with Pullup Resistor of 1kΩ at 400kHz
Figure 54. Output Signal with Pullup Resistor of 4.7kΩ at 100kHz

Figure 55. Output Signal with Pullup Resistor of 4.7kΩ at 400kHz
**Bidirectional Level Translator**

![Bidirectional Level Translation Application Diagram](image)

**Figure 56. Bidirectional Level Translation Application Diagram**

**Description**

Any pair of adjacent ports can form a bidirectional level translator path. Only the lower index port of the pair needs to be configured to enable this mode. The other port (index+1) must be set in high-impedance mode. The two PIXI ports should operate with an open-drain driver when it forms a bidirectional level translator path. External pullup resistors are also needed to meet proper logic levels.

![Bidirectional Level Translator](image)

**Figure 57. Bidirectional Level Translator**
PIXI Implementation

Configure ports 2, 3 as two terminals of a bidirectional level translator and ports 4, 5 as two terminals of a bidirectional level translator. Save bidirectional level translator register file.

Test Methodology

Required equipment:

- MAX11300EVKIT board
- Micro A-to-B USB
- PC with Windows OS
- Control Center Serial software
- Aardvark I2C/SPI™ Host Adapter
- DC power supply
- Oscilloscope
- MAX31875EVKIT board
- Through-hole resistor (2kΩ)

Test Procedure

Open the MAX11300 EV KIT Software and load bidirectional level translator register file. Connect the Aardvark I2C/SPI Host Adapter to the PC, then connect the SCL and SDA wire to ports 2, 4 with a 2kΩ pullup resistor and 3.3V power supply. Open the Control Center Serial software. Under the I2C control panel, set the bit-rate frequency to 100kHz. Connect ports 3, 5 on MAX11300EVKIT to MAX31875EVKIT’s SCL and SDA pins. Connect SCL and SDA with a 2kΩ pullup resistor and 1.8V power supply. Use Aardvark I2C/SPI Host Adapter send a read command to read MAX31875’s temperature threshold register (T_HYST). Default value of T_HYST is 4B00h. Use the oscilloscope to display signals at ports 2–5 of the MAX11300EVKIT.
Test Results
As you can see from test results in Figure 59 and Figure 60, a 3.3V SCL and SDA signal at 100kHz and 400kHz from the Aardvark I2C/SPI Host Adapter is translated to a 1.8V signal to read the MAX31875 temperature threshold register value.

Figure 59. Input and Output at 100kHz

Figure 60. Input and Output at 400kHz
**Trademarks**

Aardvark I2C/SPI is a trademark of Total Phase, Inc.

PIXI is a trademark of Maxim Integrated Products, Inc.

Windows is a registered trademark and service mark of Microsoft Corp.
## Revision History

<table>
<thead>
<tr>
<th>REVISION NUMBER</th>
<th>REVISION DATE</th>
<th>DESCRIPTION</th>
<th>PAGE(S) CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1/18</td>
<td>Initial release</td>
<td>—</td>
</tr>
</tbody>
</table>

©2018 by Maxim Integrated Products, Inc. All rights reserved. Information in this publication concerning the devices, applications, or technology described is intended to suggest possible uses and may be superseded. MAXIM INTEGRATED PRODUCTS, INC. DOES NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. MAXIM ALSO DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED HEREIN OR OTHERWISE. The information contained within this document has been verified according to the general principles of electrical and mechanical engineering or registered trademarks of Maxim Integrated Products, Inc. All other product or service names are the property of their respective owners.